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1 Introduction
This manual is intended for users of the Nortek Vessel Mounted (VM) system who want to get

familiar with post processing using the Nortek VM Review software. 

Nortek VM Review is meant to be used for initial inspection of data recorded using the Nortek VM

system. It allows users to study the data, adjust processing parameters and export to various

export formats for further processing and reporting. 

Our recommendation is to quickly read the sections in the Getting started  chapter to get an

overview of the general workflow in Nortek VM Review. The other chapters in this manual are

mainly to be used as a reference. Using the software is the best way to get familiar with its

features. You can learn more about what certain options do using the mouse-over tooltips. 

1.1 Licensing

Nortek VM Review can only be used to open files from Nortek instruments that are licensed to

be used with Nortek VM Review. If you find that Nortek VM Review cannot open a .SigVM file

due to license restrictions, it is still possible to acquire a license after the fact. Please contact

your local sales representative for more information. 

To make sure you have the latest license installed, please do a software update before

contacting Nortek. 

1.2 Nortek online

On the Nortek website (nortekgroup.com) you will find technical support, user manuals, and the

latest software and firmware. General information, technical notes, FAQ and user experience

can also be found here.

1.3 Feedback

If you find errors, omissions or poorly explained sections in this manual, please do not hesitate

to contact us. We appreciate your comments, and your fellow users will as well.

1.4 Revision history

Version Date Supports
software
version

Notes

V3.0 26-02-2025 3.0 Licensing based on Nortek instrument serial

number, lever arm corrections

V2.10 3-09-2024 2.10 Minor performance enhancements, option to

manually check for updates

V2.9 10-07-2024 2.9 Splitting and merging .SigVM files, echosounder

improvements

V2.8 18-04-2024 2.8 File association

V2.7 01-09-2023 2.7 Layer

V2.6 26-04-2023 2.6 Spectrum, missing Review features

V2.5 01-01-2023 2.5 Renewed Review software

8
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Version Date Supports
software
version

Notes

V2.4 01-07-2022 2.4

V2.3 23-02-2022 2.2

V2.2 25-03-2021 2.1

V1 11-04-2018 1.5 Initial release

Table 1: Revision history

1.5 Contact

We recommend first contacting your local sales representative before the Nortek main office. If

you need more information, support or other assistance, you are always welcome to contact us

or any of our subsidiaries by email, phone or fax.

Email: 

support@nortekgroup.com (for technical support questions)

Phone: 

+31 88 6543700

https://www.nortekgroup.com/about/contact
mailto:support@nortekgroup.com
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2 Getting started
In this chapter you will find information on installing the software and a quick overview of

common scenarios using Nortek VM Review. 

2.1 Installation

Nortek VM Review is designed for Microsoft Windows. It is runs on Windows 10 and Windows 11.

The software has automatic update detection that is installed with the Nortek VM software

package. It checks every 30 days and will show a notification when an update is available.

Alternatively, a manual update check can be performed from the Home menu. 

2.2 Windows

The Nortek VM Review application consists of several moveable and resizable windows. These

windows can either be docked in the main application window or be floated in their own window.

Windows can also be tabbed in other windows. Tips on manipulating windows are shown in Table

2 below.

Action How to

Docking and floating · Dragging the top bar of the window

· "Float" and "Dock" in the arrow menu on the top right of each

window. 

Resizing Dragging the edges of windows

Close Cross ("Hide") button in the top right of each window

Open "View" section in the "Home" menu

Table 2: Window handling

2.3 Opening a file

Files can be loaded into Nortek VM Review in a number of ways. They are listed below. 

· By double clicking on a .SigVM or .VMDiag file in the Windows Explorer

· By dragging a .SigVM or .VMDiag file from the Windows Explorer into Nortek VM Review

· By double clicking files in the file browser

When both Nortek VM Acquisition and Nortek VM Review are installed, it might be necessary to

choose the default option for opening .SigVM and .VMDiag files. This can be done by right

clicking the file and selecting "Open with". See Figure 1 below.

9
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Figure 1: Open file with Nortek VM Review

2.3.1 File browser

Nortek VM Review has a build-in file browser. In the default layout  "Horizontal map", the

browser is located in a window on the left side of the application. The same browser is also

located in the File menu. 

Figure 2: File browser

2.3.2 Working directory

When starting up Nortek VM Review for the first time, select an initial directory to display in the

file browser by clicking the first icon on the top of the browser and select a working directory

containing some .SigVM files. This will populate the browser with the contents of the directory. 

2.3.3 Loading files

Any file can be opened by double clicking it. Opening a non-.SigVM file will open it in its default

application. When opening a .SigVM file, a progress bar will be shown in the bottom left of the

application indicating a file is being loaded. After the file is processed, data will be displayed in

the different windows of the application. 

Alternatively, files can also be loaded by dragging them from the Windows Explorer into Nortek

VM Review. Keep in mind that this will change the working directory to the directory containing

the file. 

2.3.4 Appending files

Multiple files with matching configurations can be loaded into Nortek VM Review by using the

append functionality found in the context menu in the folder browser. This functionality is

intended for merging files that are automatically split by Nortek VM Acquisition when the

maximum recording length is reached. 

43
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Figure 3: Append file

This functionality can be useful in combination with the export to .SigVM  feature. This allows

for the merging of two or more .SigVM files. 

Keep in mind that files need to be appended in chronological order. Also, it is not possible to

change processing options  of multiple loaded files at once. Changing the processing options of

a merged .SigVM file is possible however. 

2.4 Displaying data

After loading a .SigVM file, the entire track will be displayed in the different windows of the

application.

Figure 4: Displaying data

33

21



Getting started 11

© 2025 Nortek Netherlands  v3.0. 

2.4.1 Track selection

The selection of the track being displayed can be changed in several ways. Table 3 below shows

the options. 

Action How to

Heatmaps and plots · Change by dragging the horizontal axis or zooming using

middle mouse button. 

· Reset using "Reset zoom" in the right-click context menu

Track · Change by clicking and dragging the left mouse button along

the blue GPS track. 

· Reset using "Select full track" in the right-click context menu

Table 3: Track selection

2.4.2 Fitting data ranges

To get the color maps of the different heatmaps to fit the range of data values, the right click

menu "Set to limits" can be used. This can further be adjusted using the edit boxes above and

below the color bar. The map again has a similar feature. 

2.4.3 Layer

In the Processing menu there is an option to enable a horizontal layer. When enabled, the layer

is visible in the current plot, use the two sliders to adjust the top and bottom of the layer.

Current data from the selected layer is shown on the map , in properties  and statistics

windows and in some of the export formats. 

14 17 18
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Figure 5: Layer

Figure 5 shows current vectors from the selected layer on the map. Note that only the part of

the track where there is current data in the configured layer is displayed. 

2.4.4 Processing configuration

If there are issues with the displayed data, parameters in the "Processing" menu at the top left

of the application can be adjusted. After changing a value, the software will reprocess the data

and update the displays in the different windows The progress of the reprocessing can be seen in

the progress bar on the bottom left of the main window. 

2.5 Exporting data

In the Exports menu there are options to export the track data to a number of formats including

CSV , MATLAB , QRev  and KML. 

The "Export" button will become available when a track is loaded and any export checkbox is

selected. There is an option to export either the entire track, the section of track currently

displayed or transects . 

Note that:

· For any export, the current processing settings will be used. 

· When processing multiple recordings it might be worth considering using the "Batch

processing " feature. 

2.5.1 Location

By default, the resulting file will be exported to a folder with the name of the .SigVM file and

"_Data" added to it. The file name will be the same as the .SigVM file, with a different extension

based on the export type. The export folder and file name can be changed by clicking the

"Choose file" button next to each export type. 

34 35 30
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2.6 Exporting images

The Nortek VM Review software includes options to copy, print and export images of the plots

and the Track. 

2.6.1 Track

The map can be exported as an image using the "Copy", "Save" and "Save as Geotiff" right-click

menu options, for more information see the  Export section . There is also an option to export

the GPS track in KML format in the "Export"  menu. 

2.6.2 Plots

Plots can be copied, printed and exported using the "Image Export" section in the "File" menu,

see Figure 6 below. In this menu you can select which plots to export. Other options include

changing the size of the individual plots. A preview is shown on the left hand side. 

Figure 6: Image export menu

Note that for each of the amplitude, correlation, and echosounder plots (if available), only a

single plot is exported, of the beam or channel currently selected for that plot in the main

screen.

When a folder is selected it is possible to export the currently displayed image to either one

single file or multiple files, depending on the option selected. 

The default file names for the plots are simply the names of the plots (they don't include the full

SigVM filename).

As a quick alternative to the "Image export" menu, the different plot windows have a right-click

context menu containing an option to copy a screenshot of what is displayed. 

15
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3 Components
This chapter is a in depth overview of all the functionality in the Nortek VM Review software. It

provides a reference to the software's features. 

3.1 Track

The Track window shows current vectors and other data on a map. This section will explain the

various options and functions of the Track. 

Figure 7: Track window

3.1.1 Interaction

In general, interacting with the map is done using the mouse. This is similar to interaction with

maps in other systems. There are also shortcuts to zoom in and out (+ and - keys) as well as for

panning (arrow keys). 

3.1.1.1 Section selection

Selecting a track section is done by moving the cursor close to the blue GPS track and then

dragging the mouse until the desired section of the track is highlighted. This is only possible

when "Allow selection" in the "Map" menu is enabled. 

3.1.1.2 Rotation

The map can be rotated using the compass on the top right side of the "Track" window. To

rotate, click and drag the cursor over the compass. Double-click to switch to "North up". 

3.1.1.3 Fitting the track

By default, when a track is loaded, the map will pan and zoom to fit the GPS track within the

bounds of the "Track" window. 

After selecting a new track section, clicking the "Fit track selection to screen" button below the

compass will fit the current selection to the window. 

There is an option to disable rotation on fit in the "Map" menu, unchecking this option will keep

north up when loading tracks and fitting the track to the screen. 

3.1.2 Data

The map shows different data based on what data is available and enabled. If available, bottom-

track, current, altimeter and notes are displayed. 
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3.1.2.1 Current vectors

The current vectors can be adjusted in the "Map" menu. The interval can be changed, they can

be resized using the "Scaling" option and there are options to fit the color bar to the maximum

and minimum current values. For fitting the color scale, there is also a "Set current to limits"

option in the right-click menu of the Track. 

The current vectors displayed on the map are the average current over the full water column by

default. When a depth layer  is setup in the Processing menu, the current vectors on the map

are from this layer. 

N.B. The maximum number of vectors on the map is 1000 for performance reasons. This means

that for large tracks, not all vectors are displayed. Selecting a sub-section of the track may

display more of the vectors that the software did not show for the larger or full track section.

3.1.2.2 Export

The track can be exported to a file or copied using the corresponding options in the right-click

context menu of the Track. Selecting "Save" exports the map as an image, "Save as Geotiff"

exports the map as a georeferenced .tiff file. The context menu for the track is shown in Figure

8 below. 

Figure 8: Track export options

When exporting to Geotiff you should keep in mind that the map will be rotated to north up if it

is rotated . Exporting a map without any markers involves turning off all the map components

and disabling "Show cursor" and "Allow selection" in the "Map" menu. 

There is also an option to export the GPS track in KML format in the "Export"  menu. 

3.1.3 Custom maps

The track window supports various different map providers by default. The map provider can be

changed in the "Map" menu by changing "Source". 

Custom maps can be added in either the GeoTIFF (georeferenced .tif(f) files) or MBTiles format.

Any of the two formats can be used, but the MBTiles format has some advantages over the

GeoTIFF format. MBTiles supports different zoom levels, is quicker to import and supports large

map areas. 

11

14

12



Nortek VM Review Software Manual16

© 2025 Nortek Netherlandsv3.0.  

3.1.3.1 GeoTIFF

To add a georeferenced .tif map, add your .tif file(s) to a designated folder and then change the

"Map files" path in the "Map" menu to the folder containing the .tif files. After selecting the folder

the software will start processing the .tif files, a progress bar is shown on the bottom left of the

software. When the processing is complete the custom map(s) can be found in the "Source"

dropdown in the "Map" menu. 

In the background the Nortek VM Review has convert GeoTIFF files to the MBTiles format, the

.mbtiles files will be visible in the folder containing the .tif files. 

3.1.3.2 MBTiles

To add a MBTiles map, simply add the .mbtiles file to a designated folder and then change the

"Map files" path in the "Map" menu to the folder containing the .mbtiles files. You should then be

able to select the added map in the "Source" dropdown. 

Open source MBTiles files for various regions can be found online. For instance, the United States

National Oceanic and Atmospheric Administration (NOAA) has a page where MBTiles files can be

downloaded for US coastal regions. Additionally, various open source projects provide MBTiles

files for Europe and other regions. 

Take note that only image based .mbtiles files are supported, vector based files will not work. 

3.2 Plots

This section will explain the features of the various heatmaps and line plots, as well as the

options present in the "Plots" menu. 

3.2.1 Heatmaps

The heatmaps display current, beam amplitude and echosounder amplitude data, among others.

The different heatmaps types are separated into windows . Some heatmaps contain different

views to, for instance, display data for the different beams. These views can be accessed by

clicking the round buttons (if present) on the left side of the heatmap. 

Figure 9: Amplitude heatmap

3.2.1.1 Fitting color bar

In most circumstances the default range for the color bar does not fit the data. To auto fit the

color bar range to the data range, use the buttons next to the top and bottom of the color bar.

To manually adjust the maximum and minimum, use the text boxes located above and below

the color bar. 

For heatmaps with different views, the limits can be synced across the views using the "Sync

heatmap limits" check box in the "Plots" menu. 

8
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3.2.1.2 Unprocessed Echosounder

Sometimes there is a need to see raw echosounder data.

For echosounders, that can be achieved with the "Unprocessed echosounder" check box in the

"Plots" menu. 

3.2.1.3 Color palette

There are various color schemes available for the different types of heatmaps. They can be

changed in the "Palette" section of the "Plots" menu shown in Figure 10 below. 

Figure 10: Heatmap color palette settings

3.2.1.4 Cross section slice

A vertical cross section of the heatmap can be shown by either using the arrow button just

above the right top corner of the heatmap, or by using the "Insert slice" context menu. When

the cross section is visible, the position of the cross section can be changed by dragging the slice

cursor along the x-axis. See Figure 9 showing the vertical slice on the right-hand side.

3.2.1.5 Auto depth scale

In the "Plots" menu, there is a toggle button to enable auto fitting the detected depth to the

bottom of the heatmaps. Auto fitting is done using the "Fit" button in the "Plots" menu or the

"Reset zoom" right-click option of the heatmap. 

3.2.1.6 Filter

The "Plots" menu contains a "Filter" toggle button for removing data below the detected water

depth. 

To show data below the detected water depth, the filter can be disabled, making all data up to

the last cell visible. Keep in mind that this data should only contain the echo reflected from the

bottom. 

3.3 Properties

The "Properties" window displays information about objects currently selected. Selecting files in

the "Browser" window will show information about the file. For .SigVM files, basic recording

information is shown. 

When a recording is loaded, moving the cursor over any of the plots or the "Track" shows details

of the currently selected measurement point (ensemble) in the "Properties" window. 
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Figure 11: Properties window

3.4 Statistics

The "Statistics" window displays information on the currently selected track section. For several

metrics, minimum, maximum and average values are calculated. 

Figure 12: Statistics window

Some of the metrics might be useful during the alignment  procedure. 19
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3.5 Alignment

To correctly align the VM-ADCP and gyro (GNSS) you can use the "Alignment" menu. After

setting up the vessel for measurement, this should be one of the first things you do. 

Figure 13: The alignment menu

A correct alignment of the VM-ADCP and gyro is important since in many cases, data from the

GNSS is used to correct velocity measurements from the VM-ADCP. The most important factor is

the orientation (compass rotation) of the VM-ADCP with respect to the gyro. In ideal situations,

the gyro orientation is zero and the VM-ADCP is mounted with a -45° angle. In the real world

there usually is a small deviation from these values. This can be corrected using the tools in the

"Alignment" menu. 

3.5.1 Data collection procedure

For a good offset check, it is best to sail some lines specifically for this purpose. For the best

results, the effect of the local currents and wind must be eliminated. Since the currents and wind

cannot be assumed to be zero, it is advisable to sail two straight tracks in opposite directions. In

areas with strong currents the calibration tracks should be into or with the currents to minimize

the effect of "crabbing", i.e., large differences between track course and ship heading. 

Requirements:

· Two straight sections (can be in either one or two separate files).

· Direction into the current and wind direction for one section, away for the other.

· Length at least 500 meters or 2-3 minutes of sailing, longer tracks yield better results.

· Vessel speed similar to planned survey speed.

Corrections can be done with only one section, but results may vary depending on circumstances

(moving bed).

3.5.2 Alignment correction

When a set of track sections as described in Data collection procedure  has been collected,

load the file(s) containing the section(s) into Nortek VM Review and select the sections one by

one before clicking "Add selection" in the "Alignment" menu. Note that when the gyro orientation

has been found manually , "Lock gyro orientation" should be checked to not overwrite the

gyro orientation. 

Figure 14: Two alignment sections added

In Figure 14, two sections have been added. After adding a section a new row appears in the

table in the middle of the "Alignment" menu. This row contains values for the corrections

calculated based on the data selected for that section. 

19

20
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Corrected gyro

orientation

Calculated based on the difference between the heading and bearing of

the gyro. The heading and bearing should be equal when sailing

straight without influence from wind or current. 

Corrected VM-ADCP

orientation

Calculated from the difference in angle between the bottom-track

velocity and GNSS velocity.

Velocity correction Ratio of GNSS speed to bottom-track speed.

Table 4:  Properties in the Alignment menu

In the "Averages" section of the menu on the right, the average for each column in the

"Sections" table is calculated. These values can be directly applied by pressing the buttons next

to them. Applying the gyro and VM-ADCP orientation from Figure 14 results in the alignment

shown in Figure 15 below.

Figure 15: Alignment corrections applied

Applying the corrections should cause the black heading line to align with the track and shift the

bottom-track on top of the GNSS track. 

Note that:

· Undo will restore the correction to the previous one.

· The correction applied are saved to the configuration, they are also visible in the "Processing"

menu.

· If the gyro orientation in the "Processing" menu is valid, it can be locked before adding

sections by checking "Lock gyro orientation".

· Loading a new track does not clear the alignment data, this allows for applying the same

alignment settings to multiple files.

· Clicking on a section will bring that section in to view and invalidates the current selection.

· Data in the "Statistics " window might give more insight in the values shown in the

"Sections" table.

3.5.3 Manual gyro alignment

For more reliable results compared to the automated version described in the following sections,

the Gyro alignment can be set manually. This is done manually before data acquisition using the

map in Nortek VM Acquisition:

· While in port locate an object (landmark) straight over the bow of the vessel that is several

km away

· Locate the same object on the map and adjust the Gyro offset so that the heading line on the

map passes straight over the object

18



Components 21

© 2025 Nortek Netherlands  v3.0. 

Alternatively use two track segments in opposite direction and let the system calculate the

alignment. This assumes the leeway in both tracks is the same but in opposite direction. This

procedure is described in the Alignment correction  section. 

A misalignment of the Gyro will not cause major problems as the VM-ADCP alignment is relative

to the gyro, not to the bow of the vessel.

3.6 Processing options

In order to correctly visualize data, it might be necessary to change some of the processing

parameters in the "Processing" menu. 

Figure 16: Processing menu

After changing any value in the "Processing" menu, the software will reprocess the data and

update the displays in the different windows. For large files, this can take a while. If processing

is still ongoing while another parameter is changed, the current processing task will be canceled

and processing will restart. This means that you do not need to wait for processing to finish

when adjusting multiple parameters. 

The progress of the current processing task is shown in a progress bar on the bottom left of the

application. There is also a dropdown containing simple log messages with information on file

loading, processing and exporting. 

3.6.1 Alignment

When a recording is loaded and both the GPS and bottom-track is displayed on the map, the

bottom-track can deviate from the GPS track. In many cases this deviation can be corrected by

changing the "Orientation" of either the VM-ADCP or the gyro. Ideally, this is done before doing

the measurement in Nortek VM Acquisition. See the "Alignment " section. 

Figure 17: Incorrect VM-ADCP alignment

19

19
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Figure 18: Correct VM-ADCP alignment

3.6.1.1 VM-ADCP alignment

The VM-ADCP alignment settings can be found in "Processing". Use "X", "Y" and "Z" to change

the mounting offset in cases the center of gravity of the vessel is the reference point. In most

cases the VM-ADCP is the reference point, therefore "X", "Y" and "Z" can be zero. In this case

the water line should be set to the distance between the bottom of the VM-ADCP and the water

surface. In general the water line is the vertical distance between the reference point and water

surface. The orientation is usually set to 45° or -45° since this is how the VM-ADCP should be

mounted. 

To learn more about setting up for measurements, please refer to the "Nortek VM Acquisition

Software Manual". 

In the case that the bottom-track is not aligned with the GPS track, the orientation can be

adjusted until both tracks overlap. 

3.6.1.2 GNSS alignment

If the heading line on the map deviates from the track, the gyro alignment might be off.

Checking the gyro alignment can be done by looking at a straight track section with little cross

current and cross wind. Moving the cursor over the track will display the heading line. This line

should be aligned with the track, this can be adjusted by changing "Orientation" in the "gyro

alignment" section of the "Processing" menu. 

Figure 19: Incorrect GNSS alignment
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Figure 20: Correct GNSS alignment

3.6.1.3 Diagram

For visualizing the offsets and orientation of the instruments there is a diagram available in the

alignment sections in the Processing menu. Make sure to reference this diagram when setting up

the instrument to verify that everything is correct. A most basic setup is shown in Figure 21

below, here the VM-ADCP is set as the reference point by leaving X, Y and Z zero. The water line

is set to 60 cm above the VM-ADCP and the GNSS is positioned 2.41 m above the VM-ADCP as

can be seen in the "Left view". The "Top view" shows the orientation of the instruments in the XY

plane, the beams of the Signature 1000 are offset to -42.5° and the GNSS has a small offset of

1°. 

Figure 21: Offsets diagram

Note that the vessel outline in the offsets diagram shown in Figure 21 is drawn in approximate

dimensions and is most likely not representative of your vessel. The labeled distances however

are to scale, when a distance does not have a label it is zero. 

3.6.2 Pitch and roll corrections

When using an external pitch and roll sensor, there can be a misalignment between the Z axis of

the VM-ADCP and the Z axis of the external sensor. This misalignment will produce a current

vector that is not true "ENU”.

Any misalignment as described above can be corrected in the "Pitch and roll" section of the

"Processing" menu.  Keep in mind that when using the internal pitch and roll sensor of the VM-

ADCP, these values should be set to "0" as the internal sensor is correctly aligned with the VM-

ADCP head. 
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3.6.3 Speed corrections

Sometimes it may be necessary to apply a global correction to all velocities. The most likely

example of this is when the speed of sound in water was not known or entered incorrectly when

collecting the data. The velocity correction can be adjusted using the "Velocity correction" factor

in "Speed corrections". This factor can also be automatically calculated, see the "Alignment "

section. 

There is no option to change the speed of sound itself in Nortek VM Review (directly or indirectly

by changing the salinity). The reason is that the speed of sound is used internally in the VM-

ADCP to correct cell sizes and velocities, therefore it should be set up before starting the

measurement in Nortek VM Acquisition. The effect of having a wrong speed of sound (or salinity)

is small, the speed of sound of sea water varies between 1,450-1,570 m/s, resulting in a

maximum error of around 8% in depth and cell size. Velocities can be compensated using the

speed correction setting mentioned above, this however does not affect the cell sizes. 

To ensure valid echosounder amplitudes, the "Salinity" value in the "Speed corrections" section

should be accurate for the measurement location. If the salinity is unknown, an approximation

can be found in Table 5.

Water Salinity (ppt) Sound speed (m/s)

Fresh water 0 1481

Seawater 35 1500

Table 5: Salinity and speed of sound

The value of "Salinity" affects just the amplitudes of the echosounder. 

3.6.4 Filtering

The "Filtering" section in the "Processing" menu contains a set of criteria for what data is

processed and displayed. Using these options, bad data can be excluded. The next sub-sections

explain this in details. 

3.6.4.1 Averaging

The processing of the data visible in the heatmaps can be averaged using "Averaging" in the

"Filtering" section of the "Processing" menu. When the averaging is set to a value larger than 0,

each ensemble is reprocessed to be an average of the surrounding ensembles within the

averaging time. 

3.6.4.2 Depth range

Use the maximum depth in the "Filtering" section of the "Processing" menu to adjust the

percentage of depth that is included in the calculation of average current and velocity.

Depending on the bottom geometry and circumstances, the measured velocities close to the

bottom may be noisy and could thus be excluded from the calculation and further processing. 

Similar to the maximum depth percentage, there is a minimum value in meters to exclude a

section starting at the water level. This might be useful when the vessel influences the current

measurements. 

3.6.4.3 Correlation

Correlation is calculated for each cell and is a measure for the quality of the velocity

measurement in this specific cell. It is expressed as a percentage and in general a correlation of

50% or more is considered good. 

Changing the value for minimum correlation will influence the outcome of the average velocity

calculation as cells that do not meet the minimum will be excluded. The calculated velocity for a
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certain vertical is the average magnitude of the average velocity over the full depth, calculated

using all valid cells in this vertical. 

When cells do not meet the minimum requirement for correlation, they appear the same color

as the background of the plot. 

3.6.4.4 Amplitude

Amplitude is the signal strength of the reflected sound waves for each cell and is a measure for

the quality of the velocity measurement in this specific cell. It is expressed dB and should be at

least 30 dB for a good measurement. Changing the setting for minimum amplitude, which can

be found in the "Filtering" section of the "Processing" menu will influence the result in a similar

way as with setting the minimum correlation.

3.6.5 Correction sources

In Nortek VM Review there are certain options for changing what sources are used for the

different data streams. These options can be changed in the "Correction sources" section in the

"Processing" menu. 

Take note that in some cases the correction sources cannot be changed, this is due to the

original measurement circumstances and available data sources. 

3.6.5.1 Depth

There are several methods for calculating where the bottom is located. Depending on the

situation, one might work better than the other. The "Depth" correction source can be found in

the "Correction sources" section of the "Processing" menu. 

When choosing "Automatic", the software will choose a most realistic value for each individual

ensemble. To see what correction source was used for a specific ensemble, see the "Depth

source" field in the "Properties" window. 

3.6.5.2 Correction

Since the current velocities are measured relative to the vessel, the raw current velocities need

to be corrected with a vessel velocity. There are a few correction sources available for this

velocity correction, they are listed below.

Correction option Description

GNSS GPS velocity data

Bottom-track XYZ Bottom-track before internal rotation in instrument coordinates

Bottom-track ENU bottom-track in East Nort Up coordinates (preferred, as it has the

highest resolution)

None Current velocity is not corrected, this could only be useful for a

stationary vessel

Table 6: Velocity correction options

Using the bottom-track as a velocity correction is preferred since it is more accurate than a

GNSS. For ensembles without bottom-track, the system will fall back to GNSS velocity

correction if bottom-track was selected. 
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3.6.5.3 Lever arm Correction

The lever arm correction uses angular velocities to compensate the movement of the GNSS
antenna. The angular velocities and the mounting position of the GNSS are used to calculate the
horizontal and vertical speed of the antennae due to the angular velocity. This is then subtracted
from the antenna speed.

This option can at this moment only be used when an Advanced Navigation GNSS is present.

3.6.5.4 Other

For the correction sources other than "Depth" and "Correction", the selection contains options to

choose between the different channels. These channels refer to the different devices that were

connected during the measurement. The different options are listed below.

Correction source Description

Internal Data recorded by the VM-ADCP

Advanced Navigation Data recorded by the Advanced Navigation GNSS

Primary channel Data recorded by the first additional navigation device

Secondary channel Data recorded by the second additional navigation device

Table 7: Correction sources

3.6.6 Echosounders

If echosounder data is present in a .SigVM recording, it will be available in the "Echosounder"

window. This window may contain several views  depending on how many echosounders were

set up during the measurement.  

3.6.6.1 Background information

When a VM-ADCP has the Echosounder option enabled (which requires a separate license), it will

collect high resolution echosounder data. This data may be used to detect for example fish,

biomass or suspended sediments. VM-ADCP sensors can collect echosounder data with three

different sets of transmit and receive parameters simultaneously. In general, the Nortek VM

system will collect two types of echosounder data: one with a "standard", and one with a "pulse

compressed" transmit pulse. (See the Nortek Manual - "Principles of Operation - Signature" for

details on the different echosounder modes).

The data shown in the Echosounder heatmaps is relative volume backscattered data. This is

corrected for attenuation and distance based on methodologies presented in

http://www2.dnr.cornell.edu/acoustics/SuggestedSOP.html ("Acoustics Unpacked"). As

described on this website, the intensity of a returned echo sounder signal is dependent on signal

strength, transmission losses (spreading of the sound wave and absorption by water), the

reflective properties of the target (target reflectivity), the position of the target in the beam

(equivalent beam angle), and instrument losses. These form the echo sounder backscatter

correction, Se, which is added to the raw echo sounder backscatter to obtain Relative Volume

Backscatter, Sv. The variable Sv is available in MATLAB output files, for example, for the

Signature 1000 echo sounder 1, it is stored under the structure

A.Echo1_1000kHz.volumeBackscatter_dB. The raw, uncorrected backscatter is also available in

the Nortek VM Review exported MATLAB file. For Signature 1000 echo sounder 1, this would be

found in A.Echo1_1000kHz.amplitudeRaw_dB.

Note that the term "relative volume backscatter" is applied because instrument calibration is not

incorporated into correction calculations. To obtain the "corrected volume backscatter", the

16
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instrument calibration data would be required. Instrument calibration data is not processed by

Nortek VM Review but can be measured and stored by the user for reference (see to Nortek

Manual - ‘Principles of Operation - Signature’ for details). 

In addition, relative volume backscatter may contain a thin, low intensity band in the layers

nearest the transducer. This is caused by the "near field effect". The transducer near field region

is described in the "Acoustics Unpacked" page mentioned above as being characterized by non-

parallel wave fronts with oscillatory intensity. To quantify the near field range, they provide a

methodology, a sample calculation, and a recommendation to exclude these results. Nortek VM

Review does not quantify the limits of this region or exclude it from relative volume backscatter.

The user should perform the calculation and adjust results according to preference. 

3.6.6.2 Options

The "Echosounders" section in the "Processing" menu contains options to adjust the data

displayed in the Echosounder window.

The "Noise level" can be used to filter out noisy data, filtered out data will have no color in the

echosounder heatmap. 

3.6.7 Saving processing settings

The "Save configuration" section in the "Processing" menu contains an option to save the current

processing settings to the loaded .SigVM file. Depending on requirements, the "Backup

recording" checkbox can be checked in order to keep a backup of the original unmodified .SigVM

file in a subfolder with the name of the recording with "_Data" added to it. 

Figure 22: Saving
the configuration

3.7 Spectrum

The Nortek VM Acquisition software allows for recording spectra that can be used to study noise

issues. The files recorded in Nortek VM Acquisition are saved with a .VMDiag extension and can

be opened in Nortek VM Review. Opening a .VMDiag file works just like opening  any other

file.

8
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3.7.1 Spectrum layout

When double clicking a .VMDiag file will cause the software to change to a layout  specifically

for viewing spectra. An example is shown in Figure 23 below. 

Figure 23: Spectrum layout

Opening a standard .SigVM recording will change the layout back to the old layout.

3.7.2 Analyzing a spectrum

Analyzing noise issues using a frequency spectrum can be a difficult task since the spectrum is

influenced by a lot of different parameters. In general, a narrow, broad or ultra bandwidth

spectrum should have a well defined single center peak around its main instrument frequency

with a width increasing with the bandwidth. The full bandwidth spectrum is over a much wider

frequency range and shows a drop-off after the peak around the main instrument frequency. 

In the time domain, the spectrum should not change significantly, this means that there should

be no horizontal lines or dots in the heatmap shown in the bottom of the "Spectrum" window. 

Some examples of what clean and noise polluted spectra look like are shown in Table 8 below.

The noisy spectra are polluted with a 50kHz square wave from about halfway the through the

recording, the clean spectra show little pollution. 
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Bandwidth Clean Polluted

Narrow

Broad

Ultra

Full
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Table 8: Spectrum examples

3.8 Exports

Exporting data is done using the "Exports" menu. In this menu you will find options on what data

to export, where to export it to and some format specific options. A preview of the "Export"

menu is shown below in Figure 24. 

Figure 24: Exports menu

For all export formats one can choose between "Full track", "Current selection" and "Transects".

"Full track" exports the entire track from start to end regardless of the track section currently

selected. "Current selection" export what is currently selected . 

The "Transects" option can useful when several transects of for example a river are recorded

into a single file. When exporting transects, the software will attempt to cut the currently

selected track section into transects. These transects are cut at points where the heading of the

vessel crosses the average current, which is usually where the vessel turns to start a new

transect. Exporting transects works best when the track is sailed in and "8" shape or a shape

resembling a circle or rectangle, results may vary with differing track shape and average

current strengths. A common use case is exporting transects to the QRev software where they

are automatically detected and validated with limited user input. 

3.8.1 Exporting to QRev

QRev is a useful tool when calculating discharge from vessel mounted systems like the Nortek

VM system. Nortek VM Review supports exporting to QRev and contains options to make

exporting multiple transects convenient. 

When "QRev" is selected as output format in the "Export" menu, see Figure 24, the QRev export

sections become available. For manual exporting manually select a transect, select "Current

selection" and fill in the available settings in the "QRev export settings" section. These settings

will show in QRev when importing the exported file. 

When exporting from a recording containing multiple transects, select "Transects" to split the

track into transects. The software will automatically detect the starting edge and distance to the

banks for each transect. To get correct distances it is required to fill in the shortest distance to

the left and right bank in the current selection in the corresponding fields. An example is given in

Figure 25 below. Here the estimated shortest distance to the left bank is 9 meters, for the right

bank this it is 8 meters. 

11
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Figure 25: Exporting transects to QRev

As can be seen in Figure 25, there is also an option to detect moving bed tests. Both the loop

and stationary type of tests are supported. The software will automatically detect the chosen

type of test in the currently selected track section and then export the "Max m.b.t. count"

number of tests. 

For loop tests, the detected loops with the largest number of ensembles are exported first. The

loops are stored in QRev files with a "loop_" prefix in their name. 

For stationary tests, the duration must be specified. Only sections with exactly the specified

duration will be detected. Stationary tests are exported to files with a "smba_" prefix in their

name. The most stationary tests are exported first, if distance traveled is too high, no stationary

tests can be detected. 

As loop tests can be detected in the transects sailed, as shown in the example in 25, we

recommend using loop tests for convenience and accurate results. 

Transects are stored in files with a "Q_transect_" prefix. The files produced by exporting with the

settings shown in Figure 25 produces the files shown in Figure 26 below.

Figure 26: QRev export files
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When opening all transects in QRev, the moving bed tests are also automatically opened.

Transects show a distance to bank calculated using the distance to the shortest bank. The edges

from the above example as shown in QRev V4.31 are shown in Figure 27 below. 

Figure 27: Edges in QRev software

3.8.2 Exporting to VMT

Despite it being a relatively dated tool, the Velocity Mapping Toolbox can be useful for

generating certain plots. Nortek VM Review supports exporting to VMT through the "Exports" or

"Batch processing" menus. 

Exporting to VMT works similar to the other export formats. By default, the generated MATLAB

files get a "V" prefix to show they are meant to be opened in VMT, unlike the files with a "Q"

prefix produced by exporting to QRev. To open the .mat file(s) in VMT, select the second option

in the File -> Open menu, see Figure 28 below.

  *Bear in mind that in order to successfully open with SonTek Mat Files option, name of the file

must contain at least 8 characters.

Figure 28: Opening exported file in VMT
(second option)

To create a plot containing the track and vectors as shown in Figure 29 below, first create a

GeoTiff  and then select "Add Background" in the "Plan View Plot" before you click "Plot Plan

View" in VMT. You will then be asked to supply the created .tif(f) file. 
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Figure 29: VMT track with current vectors

3.8.3 Exporting to SigVM

To facilitate splitting and merging of .SigVM recordings, an export to .SigVM is available.

Exporting to .SigVM works like any other export. Exporting a selection of a .SigVM file can be

useful when only part of a recording is of interest. In combination with the append

functionality , multiple files can be merged into one .SigVM file. 

3.8.4 Batch processing

There is a "Batch processing" menu for situations where several files need to all be exported to

any of the supported export formats. The "Batch processing" menu is shown in Figure 30 below. 

Figure 30: Batch processing menu

The menu contains options to select input and output folders. Next to this there is an option to

either use the "Default" processing settings that are included in each .SigVM file or to use the

"Processing settings" from the currently loaded recording. These settings can be seen in the

"Processing " menu. The "Start" and "End" in "Track range" allow for exporting a certain

range of all .SigVM files in the "Source folder". 

Notes from all recordings are collected in a single .csv file. For each of the other selected export

formats, one file is created for each recording. 

Above the "Process" button there is a toggle to switch to "Automatic" batch processing. This will

detect newly added files and export these. This can be useful when it is required that recordings

are exported as they are created. With automatic processing off, clicking "Process" will export

all .SigVM files in the "Source folder". 

9
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3.8.5 Export formats

This section will explain the different export formats in detail. 

3.8.5.1 Comma separated - .CSV

The .CSV file contains comma delimited data in ASCII format that can be imported in any

spreadsheet program.

Header Description Units

Date_Time Date and yime in standard ISO8601 format e.g. 2019-03-
15T11:22:16.93

-

EnsNo Ensemble number -

BT1Depth Bottom-track depth as measured on beam 1 m

BT2Depth Bottom-track depth as measured on beam 2 m

BT3Depth Bottom-track depth as measured on beam 3 m

BT4Depth Bottom-track depth as measured on beam 4 m

BTDepth Average depth as measured during the bottom-track
measurements

m

AltiDepth Depth as measured by the altimeter m

AltiDepthQ Quality number for the altimeter measurement -

BeamDepth Depth as measured using the amplitudes on all four beams m

DEPTH Depth as used in the calculation m

D_Source Source of the above-mentioned depth value:1= altimeter,
2= bottom-track, 3= beam amplitudes

-

VEast Current velocity, east vector m/s

VNorth Current velocity, eorth vector m/s

Vel_avg Speed of water flow, averaged over the full range m/s

Dir_avg Direction of water flow, averaged over the full range. In
degrees north.

DegreesN

LayerVEast Current velocity in layer, east vector m/s

LayerVNorth Current velocity in layer, north vector m/s

LayerVel_avg Speed of water flow in layer, averaged over the full range m/s

LayerDir_avg Direction of water flow in layer, averaged over the full
range. In degrees north.

DegreesN

Range Range of valid cells as used in the velocity calculation -

BTEast Bottom-track velocity, east vector m/s

BTNorth Bottom-track velocity, north vector m/s

GPSEast GNSS velocity, east vector m/s

GPSNorth GNSS velocity, north vector m/s

LAT Latitude (dd.dddd) Degrees

LON Longitude (dd.dddd) Degrees

GPSHeading Heading according to the GNSS compass DegreesN
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Header Description Units

GPSBearing Bearing as calculated from the GNSS positions DegreesN

DistTravelled Total distance traveled m

SHeading Heading as measured by the VM-ADCP magnetic
compass

DegreesN

SPitch Pitch as measured by the VM-ADCP Degrees

SRoll Roll as measured by the VM-ADCP Degrees

STempC Temperature as measured by the VM-ADCP Degrees Celsius

fom1 Figure Of Merit for bottom-track calculation on beam 1 (0-
65535, smaller is better)

-

fom2 Figure Of Merit  for bottom-track calculation on beam 2 -

fom3 Figure Of Merit  for bottom-track calculation on beam 3 -

fom4 Figure Of Merit  for bottom-track calculation on beam 4 -

SoundSpd Speed of sound through water m/s

Valid Validity of the data: 0 = invalid, 1 = valid -

CorrSrc What is used to correct the measured velocities: 0 =
GNSS, 1= bottom-track XYZ, 2= bottom-track ENU, 3=
none

-

BT1Vel Raw bottom-track velocity as measured on beam 1 m/s

BT2Vel Raw bottom-track velocity as measured on beam 2 m/s

BT3Vel Raw bottom-track velocity as measured on beam 3 m/s

BT4Vel Raw bottom-track velocity as measured on beam 4 m/s

Note Note taken at this timestamp -

Table 9: CSV export format

3.8.5.2 MATLAB

The MATLAB export creates file that contains several structures in a format as used by the Velocity
Measurement Toolbox. 

It fills a structure ‘A’ with the following structures:

Structure Details

A.Sup Supporting data 

A.Wat Water data (velocity and direction for each cell)

A.Nav Navigation data including GNSS and bottom-track speed and
velocity.

A.Sensor Sensor data like temperature, roll and pitch

A.Q Discharge related data (not available from a Nortek VM system)
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Structure Details

A.Echo1 Echosounder data – (Only when enabled in the instrument)

A.Echo2 Echosounder data – (Only when enabled in the instrument)

Table 10: MATLAB export structure

Echosounder data is only available if data was collected with an instrument that has echosounder

capabilities.

3.8.5.2.1 A.Sup Structure

‘noe’ = Number Of Ensembles

‘’bins’ = Number Of Bins

Field name Matrix format Description

note1  (1) Software information

note2 (1) Instrument type, serial and firmware information

serialnr (1) Serial number

frequency_kHz (1) Instrument main transducer frequency (kHz)

samplerate_hz (1) Sample rate in ensembles per second

bins (1) Default number of bins

nBins (noe,1) Number of bins in the ensemble per ensemble 

binSize_cm (bins,noe,1) Size of each bin in cm

blank_cm (1) Blanking in cm

draft_cm (1) Draft in cm

mounting_depth_m (1) Mounting depth in meters

mounting_angle (1) Mounting angle in degrees

binSize_m (1) Size of each bin in meters

blanking_m (1) Blanking in meters

draft_m (1) Draft in meters

ensNo (noe,1) Ensemble number

npings (noe,1) Number of pings as averaged for this ensemble

noEnsInSeg (noe,1) Number of ensembles in the whole segment

noe (1) Number of ensembles

averaging_time_sec (1) Averaging window size in seconds

intScaleFact_dbpcnt (1) Scaling factor for counts to dB conversion

intUnits (1) Internal units - “counts”

vRef (1) “NONE” <not used>

wm (1) 0 <not used>
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Field name Matrix format Description

units (1) Units as used for output “m” or “cm”

year (noe,1)

month (noe,1)

day (noe,1)

hour (noe,1)

minute (noe,1)

second (noe,1)

sec100 (noe,1)

timeElapsed_sec (noe,1) Seconds since start of measurement

timeDelta_sec100 (noe,1) 0 <not used>

avg_vEast (noe,1) Average velocity east

avg_vNorth (noe,1) Average velocity north

avg_vMag (noe,1) Average velocity magnitude

avg_vDir (noe,1) Average velocity direction

layer_avg_vEast (noe,1) Average velocity east in layer

layer_avg_vNorth (noe,1) Average velocity north in layer

layer_avg_vMag (noe,1) Average velocity magnitude in layer

layer_avg_vDir (noe,1) Average velocity direction in layer

altimeter_depth (noe,1) Depth as measured by the altimeter (m)

altimeter_q (noe,1) Quality of the altimeter depth measurement

bottomtrack_timestamp (noe,1) Timestamp of the bottom-track measurement

bottomtrack_ensemble (noe,1) Ensemble nr of the bottom-track measurement

bottomtrack_avgDepth (noe,1) Averaged depth as measured using bottom-track

bottomtrack_lat_deg (noe,1) Bottom-track latitude

bottomtrack_long_deg (noe,1) Bottom-track longitude

amplitudeBeam_avgDepth (noe,1) Averaged depth as measured using Amplitudes of
the four beams

valid_data (noe,1) Validity of the data: 0 = valid (any non zero value
means invalid data),
1 = no bottom-track, 2 = no bottom detected, 4 =
no velocity

FOM1 (noe,1) Figure Of Merit for beam 1

FOM2 (noe,1) Figure Of Merit for beam 2

FOM3 (noe,1) Figure Of Merit for beam 3

FOM4 (noe,1) Figure Of Merit for beam 4

first_bin (noe,1) First bin in the vertical as used for the average

last_bin (noe,1) Last bin in the vertical as used for the average
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Field name Matrix format Description

soundspeed (noe,1) Speed of sound through water in m/s

Table 11: MATLAB Sup structure

Example:

  Sup =

      scalar structure containing the fields:

        absorption_dbpm =

           0.50100
           0.50100
           0.50100
           0.50100
           0.50100

        bins =

           75
           75
           75
           75
           75

        binSize_cm =

           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000
           20.000   20.000   20.000   20.000   20.000

           20.000   20.000   20.000   20.000   20.000 
      nBins = 75
      blank_cm = 25
      draft_cm = 12
      ensNo = 

          4676
          4677
          4678
          4679
          4690
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3.8.5.2.2 A.Sensor structure

Data from the internal sensors like temperature, roll and pitch.

Field name Matrix format Description

sensor_type (1) A letter code indicating the type of sensor. Not
used for Nortek sensors

pitch_deg (noe,1) Average pitch in degrees

roll_deg (noe,1) Average roll in degrees

heading_deg (noe,1) Average heading in degrees north

temp_degC (noe,1) Average temperature in degrees Celsius

Table 12: MATLAB Sensor structure

3.8.5.2.3 A.Wat structure

Velocity, direction, backscatter etc. for each cell.

Field name Matrix format Description

backscatter (bins,noe,4) Backscatter per bin for each of the 4 beams

correlation (bins,noe,4) Correlation per bin for each of the 4 beams

noiseFloor (bins,noe) Amplitude of last cell in decibels

binDepth (bins,noe) Depth per bin in meters

vMag (bins,noe) Magnitude of the velocity in cm/s

vMag_ms (bins,noe) Magnitude of the velocity in m/s

vDir (bins,noe) Direction

vEast (bins,noe) Velocity in east in cm/s

vEast_ms (bins,noe) Velocity in east in m/s

vNorth (bins,noe) Velocity in north in cm/s

vNorth_ms (bins,noe) Velocity in north in m/s

vVert (bins,noe) Velocity in vertical in cm/s

vVert_ms (bins,noe) Velocity in vertical in m/s

vError (bins,noe) Estimated error velocity in cm/s

vError_ms (bins,noe) Estimated error velocity in m/s

beamFreq (bins,noe) Beam frequency in kHz

percentGood (bins,noe) Percentage of good measurements in this
ensemble

velocity_correction_source (noe,1) Correction source for water current velocities, 0 =
GNSS, 1 = bottom-track XYZ, 2= bottom-track
ENU, 3 = None

Table 13: MATLAB Wat structure

Backscatter and Correlation are written as an array of 4 matrices. Each matrix contains

backscatter or correlation for a specific beam.
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3.8.5.2.4 A.Nav structure

All data related to Position and movement, both from GNSS and bottom-track.

Field name Matrix format Description

bvEast (noe,1) Bottom-track velocity east in cm/s

bvError (noe,1) Bottom-track velocity error in cm/s

bvNorth (noe,1) Bottom-track velocity north in cm/s

bvVert (noe,1) Bottom-track velocity vertical in cm/s

bvEast_ms (noe,1) Bottom-track velocity east in m/s

bvError_ms (noe,1) Bottom-track velocity error in m/s

bvNorth_ms (noe,1) Bottom-track velocity north in m/s

bvVert_ms (noe,1) Bottom-track velocity vertical in m/s

depth (noe,4) Depth as calculated from bottom-track beams,
one for each beam

dsDepth (noe,1) Depth sounder depth

dmg (noe,1) Distance Made Good

length (noe,1) Length of the total track

totDistEast (noe,1) Total Distance traveled East

totDistNorth (noe,1) Total Distance traveled North

altitude (noe,1) Altitude as reported by the GNSS

altitudeChng (noe,1) 0 <not used>

gpsTotDist (noe,1) Total distance traveled from GNSS

gpsVariable (noe,1) Combined HDOP and VDOP

gpsVeast (noe,1) Velocity East

gpsVnorth (noe,1) Velocity North

gpsHeading (noe,1) True heading as recorded by the GNSS Compass

gpsBearing (noe,1) Bearing as recorded by the GNSS. (Course Over
ground)

gpsSOG (noe,1) Speed over ground recorded by the GNSS
Compass

lat_deg (noe,1) Latitude in degrees

long_deg (noe,1) Longitude in degrees

nSats (noe,1) Number of satellites in view

hdop (noe,1) Horizontal Dilution of Position

depthSource (noe,1) Source of water depth value used, 0 = automatic,
1 = altimeter, 2 = bottom-track distance, 3 =
velocity amplitude, 4 = last cell

preferredDepthSource (noe,1) Preffered depth source, 0 = Automatic, 1 =
Altimeter, 2 = Bottom-track distance, 3 = Velocity
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Field name Matrix format Description

amplitude, 4 = Last cell

bvBeam1 (noe,1) Raw bottom-track velocity from beam 1

bvBeam2 (noe,1) Raw bottom-track velocity from beam 2

bvBeam3 (noe,1) Raw bottom-track velocity from beam 3

bvBeam4 (noe,1) Raw bottom-track velocity from beam 4

gnssHeave (noe,1) Heave motion in meters, as recorded by the
GNSS

timestamp (noe,1) MATLAB compatible timestamp. A number that
represents the whole and fractional number of
days starting from a fixed, pre-set date (January
0, 0000).

Table 14: MATLAB Nav structure

3.8.5.2.5 A.Echon_xxxkHz structure

Echosounder data. Only available when enabled in the instrument. 

The name shows which Echosounder mode is used for this dataset. The n is the number of the

specified echosounder settings in the start-up configuration. The xxx is the frequency. 

An echosounder setting that uses pulse compression can output process the result using 5

different frequency bands. So, this gives a number of virtual echosounder data files, each having

a different frequency. When for example a Signature 100 is used with dedicated echosounder

the output may contain Echo1_74kHz, Echo1_82kHz, Echo1_91kHz..etc.

The exact center frequency used to process a single band is available in the data itself, and this

may be slightly different from the one as shown in the title of the set. For example, the ‘74 kHz’

is actually 73.8 kHz.

Field name Matrix format Description

noe (1) Number of ensembles

index (1) Echosounder index (0 based)

binSize_m (1) Size of each bin in m

blanking_m (1) Blanking distance in m

xmit_ms (1) Transmit length in milliseconds.

noiselevel_dB (1) Echosounder noise level in decibels

powerlevel_dB (1) Echosounder transmit power level in decibels

pulsecomp (1) Pulse compression (0 is off, 1 is on)

bins (1) Number of bins

frequency_kHz (1) Transmit frequency in kHz

amplitudeRaw_dB (bins,noe) Return in dB, uncorrected

amplitudeCorrected_dB (bins,noe) Return in dB, with range correction

volumeBackscatter_dB (bins,noe) Volume backscatter strength dB

pointBackscatter_dB (bins,noe) Point backscatter strength dB
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Field name Matrix format Description

firstCellDepth_m (1) Depth of first cell in m, corrected for speed of
sound, including mounting depth.

lastCellDepth_m (1) Depth of last cell in m, corrected for speed of
sound, including mounting depth.

binDepth_m (bins,1) Distance of this cell/bin to the sensor.

ensNo (1,noe) Ensemble number

lat_deg (1,noe) Latitude in degrees

lon_deg (1,noe) Longitude in degrees

Timestamp (1,noe) MATLAB compatible timestamp. A number that
represents the whole and fractional number of
days starting from a fixed, pre-set date (January
0, 0000).

Table 15: MATLAB Echo structure

3.8.5.3 Signature VM File Format

Data is recorded in a file with the SigVM extension. This is a zipped file containing several

individual files with data from the VM-ADCP (Signature) sensor, GPS, compass and settings. To

view the individual files, use a standard tool for opening zip archives. Figure 31 below shows the

extracted files present in a zipped .SigVM file. 

Figure 31: Contents of a decompressed .SigVM file

The file with the extension .AD2CP contains the raw data as collected from the VM-ADCP in the

standard format that is used on all Nortek AD2CP instruments. Details are available in the

document N3015-007-Integrators-Guide-AD2CP. This data can be read and processed in other

Nortek software packages like OceanContour.

The *.XML file contains all settings of the instrument and the software that were used while

collecting the data. Navigation data is stored in the *.gps, *.compass and / or

*.AdvancedNavigation (or .anpp) files. The .GPS and *.compass files (if present) contain

navigation data in standard, readable, NMEA format. A *.AdvancedNavigation or .anpp file will

contain binary data in the ANPP format as described in the Advanced Navigation ‘GNSS Compass

Reference Manual’.

https://support.nortekgroup.com/hc/en-us/articles/360029513952-Integrators-Guide-Signature
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4 Personalization
Nortek VM Review has various options for personalization including themes, different layouts

and various other settings. 

4.1 Layout

Changing the layout of the different windows that make up the application can be done using the

"Home" menu. 

Figure 32: Selecting a layout

4.1.1 Switching layout

There are a number of default layouts that can be loaded by selecting them in the "Layouts"

drop down (this can take a few seconds). 

4.1.2 Creating layouts

After adjusting a certain layout  by resizing, moving, hiding or unhiding windows, custom

layouts can be saved. This is done by typing a name for the layout in the text box on the bottom

row of the "Layouts" drop down and clicking the save button. 

Custom layouts can be removed by clicking the bin button next to each custom layout below the

divider in the "Layouts" drop down. 

When exiting the application any unsaved changes to layouts will be discarded. The choice of

default or saved layout will be remembered when restarting the application. 

4.1.3 Menu bar

The menu bar of Nortek VM Review is a so called "Ribbon" menu, similar to what Microsoft uses

in its Office suite applications. The ribbon can be be left expanded if required. This is either done

by double clicking any menu label, or by clicking the down arrow on the top right of the

application and selecting "Expand the ribbon". 

8
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4.2 Theme

Changing the theme can be done using the "Theme" drop down in the "Home" menu. 

Figure 33: Selecting a theme

When changing a theme, the color scheme of the heatmaps also changes to a color scheme

fitting the theme. Heatmap color schemes can be adjusted separately . 17
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